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These operating instructions (version "01-1009") cover the OTT CTD software
versions

� OTT CTD firmware from V 1.00.0
� OTT CTD operating program from V 1.50.0

The OTT CTD firmware version can be found in the "Advanced operation" mode,
"OTT CTD" window of the operating program. The version of the operating
 program can be found via the "Info" function in the "Help" menu.

We reserve the right to make technical changes and improvements without notice.
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1 Scope of supply

� OTT CTD – 1 groundwater datalogger consisting of a communication unit with installed
O-ring, pressure probe cable with pressure compensation capillary and
Kevlar core for longitudinal stabilization, 2 desiccant capsules, pressure probe
with integrated conductivity sensor and datalogger

– 3 x 1.5 V batteries, alkaline (LR6 · AA) or lithium design (FR6 · AA)
– 1 brief Instructions
– 1 factory acceptance test certificate (FAT)

2 Order numbers

� OTT CTD Groundwater datalogger 55.445.001.9.0
Information needed for order
– Measuring range:0 … 4 m;

0 … 10 m;
0 … 20 m;
0 … 40 m;
0 … 100 m

– System length: 1,5 … 200 m (±1 % ±5 cm)
– Battery type: alkaline, lithium

� Accessories Installation kit 55.440.025.9.2
consisting of: adapter ring 1", adapter
plates 2", 4", 6", suspension bracket

Adapter plates 3" and 5" 55.440.444.4.1

Suspension brackets 55.440.450.4.1
for top caps starting at 2" without recess
and for universal installation

Cable suspension unit on request 
for OTT CTD system lengths of > 100 m

CD-ROM „OTT CTD Software“ 56.571.000.9.7
OTT CTD operating program for PC

Top cap
with integrated fastening hook
– for 2" observation wells 24.220.052.9.5
– for 4" observation wells 24.220.054.9.5
– for 6" observation wells 24.220.057.9.5

Intelligent top cap OTT ITC 55.530.0xx.3.2
for GSM remote data transfer

5-sided key 20.250.095.4.1
to lock OTT top caps

Optical OTT Duolink reading head 55.520.017.4.2

Optical OTT IrDA link USB reading head 55.520.026.9.2

Calibration container 55.445.025.9.2
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� Alkaline battery 96.800.004.9.5
LR6 · AA; 3 units required

Lithium battery 97.800.008.9.5
FR6 · AA; 3 units required

Desiccant capsules 97.100.280.9.5
2 in aluminum bags

Conductivity calibration solution
– 0,1 mS/cm; 1000 ml 55.495.350.9.5
– 0,5 mS/cm; 946 ml 55.495.351.9.5
– 1,412 mS/cm; 1000 ml 55.495.352.9.5
–12,856 mS/cm; 946 ml 55.495.353.9.5
– 47,6 mS/cm; 1000 ml 55.495.354.9.5

3 Basic safety information

� Read these operating instructions before using the OTT CTD for the first time!
Become completely familiar with the installation and operation of the OTT CTD
and its accessories! Retain these operating instructions for later reference.

� The OTT CTD is used to measure groundwater levels, the water temperature
and the specific conductivity of the groundwater. Only use the OTT CTD as
described in these operating instructions!
For further information, ➝ see Chapter 4, "Introduction".

� Note all the detailed safety information given within the individual work steps.
All safety information in these operating instructions are identified with the
warning symbol shown here.

� Ensure the electrical, mechanical, and climatic specifications listed in the
technical data are adhered to.
For further information ➝ see Chapter 11, "Technical data".

� Handle the pressure probe cable carefully: Do not kink the cable or pull it
across sharp edges!

� Do not make any changes or retrofits to the OTT CTD. If changes or retrofits
are made, all guarantee claims are voided.

� Have a faulty OTT CTD inspected and repaired by our repair center. On no
account carry out repairs yourself!
For further information ➝ see Chapter 19, "Repair".

� Dispose of the OTT CTD properly after taking out of service. On no account put
the OTT CTD into the normal household waste.
For further information ➝ see Chapter 20, "Notes about the disposal of old units".

Replacement
parts/
Consumable
materials
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4 Introduction

The OTT CTD groundwater datalogger provides precise measurement and record-
ing of groundwater levels and temperatures, as well as the specific electrical
conductivity of the groundwater. The OTT CTD also calculates the salinity and a
TDS value (Total Dissolved Solids) based on the specific conductivity.

The pressure probe uses the hydrostatic pressure of the water column above a
relative pressure measuring cell to determine the water level. A pressure compen-
sation capillary in the pressure probe cable gives the measuring cell the current
ambient air pressure as a reference. Erroneous measurement results due to atmos-
pheric air pressure fluctuations are thus eliminated. The OTT CTD measures the
specific electrical conductivity using a 4-electrode conductivity sensor with inte -
grated temperature sensor. The measurement electrodes are made of graphite.

The temperature compensation process for the conductivity measurement and the
reference temperature used can be chosen as well as the calculation method for
the salinity.

The OTT CTD is available with five water level measuring ranges:
� 0 … 4 m water column (0 ... 0.4 bar)
� 0 … 10 m water column (0 ... 1 bar)
� 0 … 20 m water column (0 ... 2 bar)
� 0 … 40 m water column (0 ... 4 bar)
� 0 … 100 m water column (0 ... 10 bar)

With the help of a reference value that is input during startup, the OTT CTD’s
standard setting provides measurement results in the form of depth values. Alter-
natively, measured values can be levels or pressures. The measurement intervals
(sample intervals) can be preselected as necessary.

The operating parameters are adjusted with the "OTT CTD Operating program"
PC software. This software allows the system to be conveniently and flexibly
tailored to a wide range of measurement requirements. The software can be set
to provide a basic or an advanced operator interface. The basic operator inter-
face allows all settings to be adjusted within a single program window. In the
advanced operator interface, the sample interval can be controlled with limit
events, for example. The software also supports the execution of pump tests.

The stored measured values are made available through an infrared interface
(IrDA) for wireless readout by a PC with OTT CTD Operating program or OTT
Hydras 3 or by a PDA with OTT Hydras 3 Pocket.

Together with an OTT ITC intelligent top cap (accessory), remote data transfer
and remote parameter input is possible via the GSM mobile telephone network
(GSM = global system for mobile communications). The remote data transfer can
be optionally carried out by SMS text messages or using the packet oriented
mobile radio transmission service GPRS (general packet radio service).

The OTT CTD is installed simply by hanging it in observation wells of 1" in diame-
ter and larger. Various adapters/suspension brackets are available as accessories
for this purpose. Three 1.5 V lithium batteries (type AA) provide an operating life
of over five years (sample interval: 1 hour; system length: 50 m). Alternatively,
alkaline batteries with a limited working life can be used.

The communication unit of the OTT CTD can withstand temporary flooding (for
details, see chapter 21, "Technical data").
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Fig. 1: Setting up a groundwater measure-
ment station with the OTT CTD.

The OTT CTD essentially consists of three com-
ponents: Communication unit, pressure probe

cable and pressure probe with datalogger.

OTT CTD system length = length of
communication unit + cable length +

length of pressure probe with datalogger.
(The system length is required when
ordering an OTT CTD. When setting

the OTT CTD operating parameters the
system length is not required.)

(The rubber stop attached to the pressure
probe cable prevents the pipe casing from

falling when the communication unit is
open. Do not move the rubber stop!)
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5 Installing, checking, and exchanging batteries

Please note

� Only use the battery types indicated (no rechargeable batteries)!
� Always use brand new batteries! Do not mix used and new batteries!
� Do not mix batteries of different manufacturers!
� Do not mix lithium and alkaline batteries!
� Properly dispose of dead batteries! Do not include in household waste!

Suitable battery types

3 x 1.5 V AA cells (LR6/FR6),
alkaline or lithium design (LiFeS; Energizer L91)

Insert the batteries as follows

� Slide the pipe casing of the communication unit approximately 30 cm in the
direction of the pressure probe cable.

� Insert 3 batteries (LR6/FR6 · AA) in the battery compartment
as shown in Figure 2. Ensure that the polarity is correct!

� Screw the pipe casing of the communication unit back on.

Notes

� The OTT CTD begins measurements within a few seconds of the batteries being
inserted  (there is no on/off switch).

� If the OTT CTD is to be shut off ➝ remove the batteries. This will prevent the
batteries from draining prematurely and will stop any recording of unusable
measurements.

� When bringing back into operation it takes – dependent on how much data is
stored – up to 7 minutes until the OTT CTD begins measurements again.

Pipe casing
communication

unit

Battery compartment

LR6/FR6 · AA
Battery

Backstop

+
+

+

Fig. 2: Installing batteries.
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Battery life

For a 1 hour sample interval an 50 m system length (without ITC).
� Lithium batteries: at least 5 years
� Alkaline batteries: at least 1.5 years (high quality battery types)

Notes

� The operating program has a calculation function that determines the approxi-
mate battery life based on the operating parameters currently set. The basis for
this are lithium batteries!

� Due to their design, at 0 °C, alkaline batteries drop to 50 % of their original
20 °C capacity  and at  –10 °C they drop to approximately 35 %. If ambient
temperatures are expected to drop below 0 °C at the measurement station, it
is recommended that lithium batteries be used.

Check the battery voltage as follows

� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Select the "OTT CTD" menu, "View Instantaneous values" function 1) ➝ the

OTT CTD starts an instantaneous value measurement ➝ the "Observer"
window indicates the current battery voltage and the energy withdrawn from
the batteries so far in Ah.

� If the battery voltage is ≤ 3.6 to 3.7 volts ➝ replace the batteries.
� Click on the "Exit" button.
� Close the operating program.
1) With suitable settings (Menu "File", Function "Options"), the operating program starts with the

"Observer" window.

Replace dead batteries as follows

� Open the top cap/observation well cover.
� Pull the communication unit approximately 80 cm out of the observation well

and hold (a second person would be useful).
� Slide the pipe casing of the communication unit approximately 30 cm in the

direction of the pressure probe cable. (The rubber stop located on the pressure
probe cable (see Fig. 1) prevents the pipe casing from falling. Do not move the
rubber stop!)

� Remove dead batteries.
� Insert 3 new batteries (LR6/FR6 · AA) into the battery compartment as shown

in Figure 2 within 10 minutes. Ensure that the polarity is correct!
� Slide the pipe casing of the communication unit back on until it stops.
� Slowly and carefully place the communication unit back into the observation well.
� Close the top cap/observation well cover.

Notes

� The OTT CTD stores the measured values in a non-volatile memory. This pre-
vents any data loss when replacing the batteries. This also applies to storage
over a long time period with the batteries removed.

� If it takes longer than approx. 10 minutes to replace dead batteries, the time
(and possibly the date) will have to be re-entered (see Chapter 13, "Date and
time settings"). Furthermore, it takes – dependent on how much data is stored –
up to 7 minutes until the OTT CTD begins measurements again.

� When replacing the batteries, we recommend changing the desiccant capsules
at the same time (see Chapter 16.2, "Replacing the desiccant capsules").
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6 Installing the OTT CTD

System length up to 100 meters
The installation of the OTT CTD is carried out by suspending it in the observation well.
In the process, the necessary accessories and type of installation varies depending
on the diameter of the observation well and the design of the top cap:

� 1" observation wells see 6.1
� 2", 3", 4", 5" or 6" observation wells, see 6.2

OTT top caps with recess for adapter plate
� Observation wells beginning at 2" in diameter, see 6.3

top caps without recess for adapter plate
� Special case: Observation wells beginning at see 6.4

2" in diameter without top cap

System length over 100 meters
For installation of an OTT CTD with a system length of more than 100 meters,
there is a special cable suspension unit available (see accessories). This suspension
unit is described separately.

Adapter plate 2"

Adapter plate 4"

Adapter plate 6"

2

3

33

3 2/3

3

1

1

2

1

Fig. 3: Installation accessory set – Part 1.

1 = hole for OTT CTD
2 = hole for contact gauge

3 = recess for screws on the top cap
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Adapter plate 3"

Adapter plate 5"

33

33

1

1

2

2

Fig. 5: Adapter plate accessories 3" and 5".

1 = hole for OTT CTD
2 = hole for contact gauge

3 = recess for screws on the top cap

Suspension bracket

Adapter ring 1"

Fig. 4: Installation accessory set – Part 2.
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6.1 Installing in 1" observation wells 

� Required accessories: Adapter ring for 1" observation wells.

Install the OTT CTD as follows

� Preliminary work: If not already done, install batteries (see Chapter 5).
� Open the observation well cover.
� Determine the current depth with a contact gauge and make a note of it.
� Slide O-ring from the communication unit onto the pressure probe cable.
� Place adapter ring over the pressure probe cable and slide it until it comes

to rest against the communication unit.
� Slide O-ring back onto the communication unit.
� Place the pressure probe in the observation well.
� Slowly and carefully lower the pressure probe with the pressure probe

cable!
� Feed the communication unit into the observation well until the O-ring sits on

the observation well (see Figure 6).
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Set operating parameters (see Chapter 7).
� Close the observation well cover carefully. Caution: Do not damage the

infra-red interface (maintain correct spacing)!

Adapter ring 1"

O-ring

Communication unit

Observation well cover 
(example)

Infrared interface

 1" Observation well

Fig. 6: Installing the OTT CTD
in 1" observation well.
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6.2 Installing in 2", 3", 4", 5" or 6" observation wells,
top cap with adapter plate recess

� Required accessories: OTT top cap with appropriate sized recess and the
matching adapter plate.

Install the OTT CTD as follows

� Preliminary work: If not already done, install batteries (see Chapter 5).
� Open the top cap cover.
� Insert correctly sized adapter plate into top cap.
� Pass pressure probe through the hole in the adapter plate.
� Slowly and carefully lower the pressure probe into the observation well

with the pressure probe cable (see Fig. 8)!
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Pass the communication unit through the hole in the adapter plate until the

O-ring sits on the adapter plate (see Fig. 7).
� Determine the current depth with a contact gauge and make a note of it.
� Set operating parameters (see Chapter 7).
� Close the top cap.

Adapter plate 2"

Communication
unit

Recess

O-ring

OTT Top cap

Fig. 7: Installing the OTT CTD in 2",
3", 4", 5" or 6" observation wells.

Example: 2" observation well
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Recess

Top cap

Communication unit

O-ring

Adapter plate

Fig. 8: Installing the OTT CTD.
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6.3 Installing in observation wells beginning at 2" in diameter,
top cap without adapter plate recess

� Required accessories: Top cap with attachment screw for the top of the top cap.
Suspension bracket.

Caution: There must be sufficient space in the top cap for the infrared interface
to not be damaged when the top of the top cap is closed!

Install the OTT CTD as follows

� Preliminary work: If not already done, install batteries (see Chapter 5).
� Open the top cap cover.
� Remove the upper part of the top cap (see Fig. 9).
� Place the suspension bracket on the screw (see Fig. 9).
� Reattach the upper part of the top cap (see Fig. 9).
� Pass the pressure probe through the holes in the suspension bracket.
� Slowly and carefully lower the pressure probe into the observation well

with the pressure probe cable!
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Pass the communication unit through the holes in the suspension bracket until

the O-ring sits on the suspension bracket (see Fig. 10).
� Determine the current depth with a contact gauge and make a note of it.
� Set operating parameters (see Chapter 7).
� Close the top cap.

Suspension
bracket

Screw

Top cap 
upper part

Fig. 9: Installing the suspension bracket in
observation wells beginning at 2" diameter

with a top cap without a recess.

Example: 4" observation well
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Caution: For top caps with installed suspension brackets, never completely
remove the screw in the top cap! Otherwise, the suspension bracket and the
OTT CTD will fall into the observation well!

O-ringSuspension
bracket

Communication
unit

Top cap 
upper part

Screw

Infrared
interface

Fig. 10: Installing the OTT CTD in obser-
vation wells beginning at 2" diameter

with a top cap without a recess.

Example: 2" observation well
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6.4 Installing in observation wells beginning at 2" diameter
without a top cap

For this installation case, an individual solution to fasten the OTT CTD must be
found depending on the measurement station. Example: fix a suspension bracket
with an M6 hex bolt/nut laterally at the upper end of the observation well.

� Required accessories: Suspension bracket; for example: M6 hex bolt, plate
and M6 hex nut.

Install the OTT CTD as follows (example)

� Preliminary Work: If not already done, install batteries (see Chapter 5).
� Make a hole (Ø 6.5 mm) laterally at the upper end of the observation well.
� Attach the suspension bracket with an M6 hex bolt and M6 hex nut (both

stainless steel) to the observation well (see Fig. 11).
� Pass the pressure probe through the holes in the suspension bracket.
� Slowly and carefully lower the pressure probe into the observation well

with the pressure probe cable!
� Raise and lower the pressure probe in quick succession approx. 30 cm ➝ this

removes any air bubbles in the conductivity sensor.
� Pass the communication unit through the holes in the suspension bracket until

the O-ring sits on the suspension bracket (see Fig. 10).
� Determine the current depth with a contact gauge and make a note of it.
� Set operating parameters (see Chapter 7).

Suspension
bracket

Hex nut

Plate

Hexagon bolt

Observation
well

Fig. 11: Example installation of an
OTT CTD in an observation well

beginning at 2" diameter.

Proceed similarly for
other local conditions!
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7 Setting OTT CTD operating parameters

To set the OTT CTD operating parameters you need the PC software "OTT CTD
Operating program" (WBSPL0.exe). This software is contained on the "OTT CTD
Software" CD-ROM (accessory).

Hardware and software requirements: see CD insert.

7.1 Installing the OTT CTD operating program

Install the OTT CTD operating program as follows

� Insert the OTT CTD Software CD-ROM into the drive of the PC.
� Start the "setup.exe" file in the "\Software\Deutsch" 1) directory (e.g. double

click on the file symbol) ➝ the Setup Assistant opens and guides you through
the installation.

� Follow the installation instructions on the screen.

1) Alternatively: "\English" or "\Français" or "\Español"

7.2 Establishing a communication link from PC to OTT CTD 

In the following chapters, establishing a communication connection between the
OTT CTD and a PC is a pre-requisite for the subsequent steps. The following
description illustrates the various methods of setting up this communication link.

The communication between the OTT CTD and a PC is established without contact
via invisible infrared light (IrDA interface).

Required accessories:

� OTT Duolink reading head 1) or
� OTT IrDA-Link USB reading head
1) with PCB version "b": see label on the connection line

Note

� Together with a modem and the OTT ITC intelligent top cap, it is possible to
establish a remote communication connection. See online help.

How to establish a communication link

� Start the OTT CTD operating program.
� Change the language for the OTT CTD operating program as required:

Press function key "F3" (multiple times) until the required language appears.
� In the start window, press the "Setup device" button ➝ the operating program

displays the "Basic operation" window. No operating parameters for the
OTT CTD are visible yet.

– Setting up a communication link with the OTT Duolink reading head:

� Connect the OTT Duolink reading head to a serial PC interface (COM1, etc.).
� Place the OTT DuoLink reading head on the OTT CTD infrared interface

(see Fig. 12).
� In the OTT CTD operating program, select the communication path "IrDA –

OTT DuoLink" and the serial interface used (COM1, etc.).
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– Setting up a communication link with the OTT IrDA-Link USB reading head:

� Connect the OTT IrDA-Link USB reading head to a USB interface on the PC.
(USB interface drivers must be installed, see separate installation instructions.)

� Place the OTT IrDA-Link USB reading head on the OTT CTD infrared interface
(see Fig. 12).

� Select the communication path "IrDA – OTT IrDA-Link" in the operating
 program.

Notes

� The integrated infrared interface of a PC (standard for many notebooks) can
only be used with the Windows 95 and Windows NT operating systems!

� The OTT CTD infrared interface has a radiation angle of approx. ±15 °.
� Caution: OTT CTD connected to OTT ITC: Establishing a communication

 connection can take up to a minute! (This is always the case if the OTT CTD
attempts to communicate with the OTT ITC (e.g. SMS message) and the OTT ITC
is open at the time.)

Fig. 12: Establishing a communication
link PC/OTT CTD.
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7.3 Setting OTT CTD operating parameters

How to set the OTT CTD operating parameters

� Click the "Read" button (alternatively: Menu "OTT CTD", function
"Read") ➝ the operating program reads the current operating parameters of
the OTT CTD.

� Adjusting operating parameters (see overview on page 21).
� If necessary: „Set up cyclical data transfer with SMS text message in combi -

nation with an OTT ITC intelligent top cap“ or „Set up cyclical data transfer
using GPRS in combination with an OTT ITC intelligent top cap“ – see below.

� Set time: adjust the proposed PC date/time or individually set date/time using
"Set date/time" (see also Chapter 13).
Caution: The operating program automatically corrects any summer time PC
adjustments.

� Click the "Program" button➝ "Warning: Reset the OTT CTD and delete data
memory additionally?" Confirm with "Yes" (recommended for initial installation
and reinstallations).
Caution: All measured values collected until now will be permanently lost!

� Check the level of the adjusted measured value (pressure sensor). See Chapter 8.
� Remove OTT DuoLink.
� Close the top cap/observation well cover.

If necessary: Set up cyclical data transfer with SMS text message
in combination with an OTT ITC intelligent top cap 1)

� Activate check box "Modem/ITC connected".
� Activate check box "SMS data transmission active".
� Click on the "ITC settings" button ➝ the operating program starts an Assistant

for setting all the necessary operating parameters.
� Enter the receiver phone no. for the data SMS. (phone number of a large

account or for a PC with GSM modem.)
� Click on the "Next" button.
� Enter SIM PIN (4-digit) of the SIM card.
� Click on the "Next" button.
� Set or enter the SMS-C phone no. of the network operator. (Phone number of

the SMS service center. The SMS-C phone number is normally already saved
on the SIM card ➝ in this case, set to "SIM card".)

� Click on the "Next" button.
� Select the SMS transfer mode.
� Click on the "Next" button.
� Set the interval for transmission of the storage values.
� Click on the "Next" button.
� Set the offset time for the transmission interval.
� Click on the "Exit" button.
� Check the settings afterwards and correct as necessary.
� Click on the "OK" button.

If necessary: Set up cyclical data transfer using GPRS in com -
bination with an OTT ITC intelligent top cap 1)

� Activate check box "Modem/ITC connected".
� Activate check box "GPRS data transmission active".
� Click on the "ITC settings" button ➝ the operating program opens a window

with several tabs for setting all the necessary operating parameters.
� Make the required settings in the "General", "Operator", "FTP" and "Time

sync." tabs. Caution: The SIM PIN for the SIM card used should be deactivated!
Otherwise enter the SIM PIN in the "Modem/ITC" tab (advanced operation
mode).

� Click on the "OK" button.

1) For further information, refer to the online help
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OTT CTD
� Number Station number, 10 characters (alphanumeric)
� Name Station name, max. 40 characters (alphanumeric)

Water level / Pressure + Temperature + Conductivity
� Number Sensor number, 4 characters (alphanumeric)
� Name Sensor name, max. 40 characters (alphanumeric)
� – Water level: Depth or level pressure

– Conductivity 0.001 … 2.000 mS/cm · 0.10 … 100.00 mS/cm
– Salinity: 2 … 42.00 PSU · 2 … 60.00 ppt

� Units – Pressure sensor: m, cm, feet, inch / bar, psi
– Temperature: °C · °F
– Conductivity: mS/cm · μS/cm
– Salinity: PSU · ppt
– TDS: mg/l

� Decimal places fixed specification, depending on the units and measuring range
– m: 3 or 2; cm: 1 or 0; feet: 2 or 1, inch: 1 or 0
– bar: 4  or 3, psi: 3 or 2
– °C: 2 or 1, °F: 2 or 1

� for the depth output type: � input contact gauge value
for the level output type: � enter staff gauge value (generate reference to the level zero)
for the pressure output type: � input reference pressure

� Sample interval 5 s … 24 h; time delay at which the OTT CTD records measured values and stores them
(store only if sample interval = mean interval). The sample interval setting is at a fixed
time raster (e.g. sample interval of 10 minutes, time raster …, 00:10, 00:20, 00:30, …).

� Storage interval 5 s … 24 h; time delay during which the OTT CTD calculates an arithmetic mean from
the sample interval values and stores it. The storage interval must be equal to or larger
than the sample interval. The sample interval must divide exactly into the storage inter-
val (e.g. sample interval: 10 minutes; storage interval: 1 hour ➝ the OTT CTD stores an
arithmetic mean from 6 sample interval values each hour).

Meas. type/Meas.range

Pressure value – set newly
Water level – set newly
Depth to water – set newly
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Additional settings for conductivity, salinity and TDS

� the mathematical algorithm on which the calculation
of the specific conductivity at a defined reference
temperature is based. Possibilities: "Freshwater";
Saltwater"; Standard method 2510"; "ISO
7888/EN 27888"; "---" (none). For the "Standard
method 2510", the reference temperature can be
selected: 20 °C or 25 °C.

� the mathematical algorithm on which the calculation
of the salinity is based. Possibilities: "Standard
method"; "USGS 2311". With the calculation
method USGS 2311, the unit is "ppt"; with the
standard method the unit "PSU" is fixed.

� With the check box activated, the datalogger saves
the values. With the check box deactivated, the
instantaneous values are still visible in the observer
window.

Other displays in the "Basic operation" window

� Measuring range Measuring range of the pressure probe – see Fig. 1
� System length Cable length including communication unit / pressure

probe (see Fig. 1)
� Date/time Internal date/time of the OTT CTD

Detailed information on the "Advanced operation" function can be found in the
online help.

Factory settings

OTT CTD
� Number Serial number
� Name OTT CTD 1

Water level/Pressure Temperature
� Number 0001 0002
� Measurement type Water level Temperature
� Type of output Water level/depth
� Unit m °C
� Decimal places 3/2 2
� Sample interval 1 h 1 h
� Storage interval 1 h 1 h

Conductivity Salinity TDS
� Number 0004 0005 0006
� Name Specific Conductivity Salinity TDS
� Unit mS/cm PSU mg/l
� Decimal places 2
� Measuring range 0.10 …100.00 mS/cm 2 … 42.00 PSU
� Temperature compensation Fresh water
� Calculation method Standard method
� Sample interval 1 h 1 h 1h
� Storage interval 1 h 1 h 1h

� deactivatedModem/ITC
connected

Store salinity
Store TDS

Calculation method
(Salinity)

Temperature compen -
sation (Conductivity)
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7.4 Saving/loading OTT CTD configuration

The functions "Load" and "Save" are provided to archive the OTT CTD configuration
on a PC. For example, you can provide multiple OTT CTDs with the same confi -
guration.

To store a configuration
� Select the "Save configuration" function in the "File" menu (or use the button)

➝ the operating program stores the configuration under the name and number
of the OTT CTD. When changes are made to a configuration that has already
been saved, confirm the window that appears: "Warning, this configuration
name already exists! Overwrite?" with "Yes" (otherwise save the configuration
under a different station number).

To load a configuration, proceed as follows
� Select the "Load configuration" function in the "File" menu (or use the button).
� For an already opened configuration, confirm "Ignore changes?" message with

"Yes" (if necessary, save configuration previously).
� In the "Saved OTT CTD Configurations" window, select the configuration by

double-clicking it ➝ the operating program loads the configuration.

7.5 Importing/exporting an OTT CTD configuration

To transfer an OTT CTD configuration, via diskette or E-mail for example, the func-
tions Import/Export are available. Likewise, a configuration can be sent via Export
as an XML file to the OTT Hydras 3 user software. In the process, the OTT Hydras 3
user software completely applies all of the measurement stations / sensor configu-
rations to an OTT Hydras 3 operating range.

Available export/import formats

� Export ("BIN" file)
� Export to a text file
� Export for the OTT Hydras 3 user software

� Import ("BIN“ file)

The operating program stores all the necessary data of a configuration depending
on the export type in its own "*.BIN", "*.TXT" or "*.XML" file.

Export a configuration as follows ("*.BIN" file)
This export type is required to transfer an OTT CTD configuration as a "*.BIN"
file. The configuration can be read back into the OTT CTD operating program via
the "Import configuration" function.

� Select the "Export configuration" function in the "File" menu.
� In the "OTT CTD   export configuration" window, edit the file name if necessary,

select the memory location and click on "Save" ➝ the operating program
stores the configuration in a  "*.BIN" file.

Note

� The file name of the "*.BIN" file is arbitrary. The operating program suggests a
combination of station number and station name.
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To export a configuration (text file)
This export type is required to transfer an OTT CTD configuration for documentation
purposes as a "*.TXT" file. This "*.TXT" file can be opened with any text editor or
text processing program.

� Select the "Export text file" function in the "File" menu.
� In the "OTT CTD   export configuration" window, edit the file name if necessary,

select the memory location and click on Save ➝ the operating program stores
the configuration in a  "*.TXT" file.

Note

� The file name of the "*.TXT" file is arbitrary. The operating program suggests a
combination of station number and station name.

To export a configuration (OTT Hydras 3)
This export type is required to transfer an OTT CTD configuration to the OTT
Hydras 3 user software. This "*.XML“ file is read in via the Hydras 3 function
"File", "Import Station Configuration (XML)".

� Select the "Export Hydras 3 (XML)" function in the "File" menu.
� In the "OTT CTD   XML configuration" window, check the file name, select the

memory location and click on Save ➝ the operating program stores the config-
uration in a  "*.XML" file.

Note

� The file name of the "*.XML" file is arbitrary. To avoid affecting later data
transfer, it should not be changed. The operating program proposes a combi-
nation of measurement station number and measurement station name along
with the ending "*.STATION.XML".

To import a configuration
� Select the "Import Configuration" function in the "File" menu.
� In the "OTT CTD   Import Configuration" window, select the appropriate "*.BIN"

file and click on Open ➝ the operating program reads in the configuration
from the *.BIN" file. (Prior to this, save any configuration that is already open).

Note

� The standard factory configuration can be found on the CD-ROM "OTT CTD
Software".
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8 Determining and displaying instantaneous values
(observer function)

The operating program has a so-called "Observer" to enable the determination
and display of instantaneous values. The observer also makes it possible to enter
a manually determined measurement, e.g. contact gauge value, into the datalog-
ger (observer registration).

Various options can be set concerning the observer:

� Selection possibility in the start window of the OTT CTD operating program:
– direct and sole call of the observer, or
– calling a window to set the operating parameters 

� Effect of an optionally entered observer registration (pressure sensor):
– observer registration is used solely as a check value, or
– observer registration leads to a change in the value (setting offset)

� Suppress the display of the instantaneous value (pressure sensor) prior to the
input of an observer registration

Set the observer options as follows

� Start the OTT CTD operating program.
� Select the "Options" function in the "File" menu. (If the option dialog cannot

be called, a password must first be entered. See Chapter 12)
� Activate the check box(es) for the observer option(s) required:

– Only observer mode
– Do not calculate manual input value with scaling

(only check value/no value change)
– Suppress previous instantaneous value display

� Click on the "OK" button.

The combination of "Only observer mode" with a password protects the operating
program against unauthorized input of operating parameters.

The "Advanced operation ..." option displays an additional button in the window
for setting the operating parameters.

Fig. 14: Input window to establish
options for the observer.

For further information on protecting
the OTT CTD operating program with

a password, see Chapter 12.
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Call the observer function as follows

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Depending on the option set: In the start window of the OTT CTD operating

program, either select "View Instantaneous Values" or "Setup device" and in
the subsequent window select the "View Instantaneous Values" function in the
"OTT CTD" menu ➝ the OTT CTD starts an instantaneous value measurement
and the "Observer" window opens:

� If necessary: Input observer registration into the entry field of the pressure
 sensor and click on the "Save" button.

� If necessary: Start new instantaneous value measurement: click on the "Refresh"
button ("� Automatic refresh" automatically starts an instantaneous value
 measurement every 5 seconds).

� End the observer function: click on the "Exit" button and close the OTT CTD
operating program.

Notes

� The OTT CTD stores each time the observer function is called in an info channel
with the date and time of day. After reading in and accepting into the OTT
Hydras 3 user software, this information can be displayed in the evaluation
window of a sensor using the "Info Data | Station | Displays" function
("Observer registration general"). They are likewise visible via the "View data",
"Table" function of the OTT CTD operating program.

� If the "Do not calculate manual input value with scaling" check box in the
"Options" window is activated, the OTT CTD also stores the input check value,
as well as the current instantaneous value. After reading in and accepting into
the OTT Hydras 3 user software, this information can be displayed in the evalu-
ation window of a sensor using the "Info Data" | "Sensor" | "Displays" func-
tion ("Observer registration with check value"). They are likewise visible via the
"View data", "Table" function of the OTT CTD operating program.

Fig. 15: Display/input window "OTT CTD
operating program – observer".

The window displays the current instanta-
neous value for all measurements.

Furthermore, the window displays the
window sensor number/name, the

current battery voltage, the amount
of power used from the batteries up

to now, and the date and time.



27

9 Reading out data

Read out data as follows (on location)

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Press the "Download Data" button in the start window ➝ the operating pro-

gram shows the available sensors and the possible read period. If these para-
meters are not visible: press the "Connect" button.

� Select the required sensors or "All sensors".
� Select the required read period or "All".
� Click the "Read out" button ➝ the operating program copies the measured

values from the OTT CTD to the PC. The data are then available in the program
directory of the operating program.

� If necessary: Display measurements via the "View/export data" function
and/or export to a software application.

� Click on the "Back" button.

Alternative possibilities for readouts:

� With the OTT CTD operating program and an OTT ITC
In conjunction with a modem and the OTT ITC intelligent top cap, it is also
possible to establish a remote communication link. See online help.

� With the PC application "OTT Hydras 3 (Basic)"
(Select the required station in the tree display by double-clicking, make the
required settings in the subsequent window and click on the "Start" button). For
further information, see the online help for the OTT Hydras 3 (Basic) software.

� With a Pocket PC and the "OTT Hydras 3 Pocket" software.
For further information, see the OTT Hydras 3 Pocket operating instructions.

Fig. 16: Read out data.
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10 Exporting data

After reading out into the OTT CTD operating program, the measurement and
information data can be found in the "RAWDATA" sub-directory of the program
directory (standard setting: "C:\Program files\OTT\OrpheusMini_CTD\RAWDATA").
To transfer to an external application, you can export the data in various formats:

� CSV – structured text file in CSV format (Comma-Separated Values)
� Excel – Microsoft Excel spreadsheet program
� OTT Hydras 3 – raw data format for the OTT Hydras 3 user software
� OTT MIS – OTT-specific file format for automatically importing into the

measurement database of the OTT Hydras 3 user software

Using the "Export Options" dialog window, you can set the location for saving
and, with CSV format, various export parameters also. The data remain in the
sub-directory after export. If necessary, you can specifically delete them.

Info data can only be exported to the OTT Hydras 3 user software.

How to export the data

Step 1 – Make export settings:

� Click on the "View/export data" button in the start window.
� In the "View/export data" window, click on the "Export Options" button (see

Figure 17).
� Enter the path to the storage location of the required export format (standard

setting: "C:\Program files\OTT\OrpheusMini_CTD\Export"). No path can be
set for the "Excel" format: the operating program automatically opens Microsoft
Excel during the export and displays the data in a new worksheet. In format
"Hydras 3" the "?" button can be used to automatically find the installation
directory of OTT Hydras 3.

� In format "CSV": set the "Field separator", "Dec. separator", "Date format"
and "Time format". For the date and time formats, the typical windows place-
holders can be used.

Step 2 – Exporting data:

� Select the required station/sensor in the list (multiple selection possible).
� Click on the "Export ..." button.
� Confirm message about successful export with "OK".
� If necessary, delete the exported data: click on the "Delete" button.
� Confirm the message with "Yes".
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11 Displaying data

After reading out into the OTT CTD operating program, the measurement and
information data can be found in the the "RAWDATA" sub-directory of the pro-
gram directory (standard setting: "C:\Program
files\OTT\OrpheusMini_CTD\RAWDATA"). For an initial check, you can display
the data graphically and numerically and print them out if necessary.

How to display the data graphically

� Click on the "View/export data" button in the start window.
� Select the required station/sensor in the list (multiple selection possible – info

data can only be displayed numerically).
� Click on the "Graphic" button ➝ the operating program displays the window

with the graphical view of the selected data;
– Show ruler: function key "F10"; Move ruler: arrow keys ← →;
– Zoom in: draw the required area by dragging with the mouse;
– Zoom out: function key "F12".

� Print graphic: Select the "Print" function in the "File" menu.
� Close graphic: Select the "Exit" function in the "File" menu (or �).

How to display the data numerically

� Click on the "View/export data" button in the start window.
� Select the required station/sensor in the list (multiple selection possible).
� Click on the "Table" button ➝ the operating program displays the window with

the numerical view of the data in the OTT data protocol;
– Only display measured values: select "Values";
– Highlight special areas (only with information data): Select "Observer &

operation", "Alarm & limit", "Communication & error", "Error & service log".
� Print numerical display: Select the "Print" function in the "File" menu.
� Close numerical display: Select the "Exit" button (or �).

How to delete the data

� Select the required station/sensor in the list (multiple selection possible).
� Click on the "Delete" button.
� Confirm the confirmation message with "OK".

Fig. 17: Display/export data.
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12 Protecting the OTT CTD and OTT CTD operating
program with a password

To prevent any unauthorized input of operating parameters, you can

� protect the OTT CTD and
� OTT CTD operating program

with a password for each.

How to protect the OTT CTD operating program with a password

� Start the OTT CTD operating program.
� Select the "Options" function in the "File" menu.
� Enter a maximum eight-digit password in the "Password" input field. Permitted

characters 0 … 9, A … Z. (This password is independent of the OTT CTD
password.)

� Activate check box "Only observer mode".
� Click on the "OK" button.
� Close the operating program ➝ the operating program is now protected: the

"Setup device" button in the start window is no longer visible.

Caution:

� If the password is lost, you can no longer configure or parameterize the
OTT CTD on this PC. If this occurs, contact the OTT HydroService.

� The password assigned here only pertains to the OTT CTD operating program
installed on this PC. The OTT CTD itself is not protected by this!

How to release a password-protected OTT CTD operating program

� Start the OTT CTD operating program.
� Select the "Options" function in the "File" menu.
� Enter the password in the "OTT CTD" window.

� Click on the "OK" button.
� Deactivate the "Only observer mode" check box.
� Remove the entry in the "Password" field.
� Click on the "OK" button ➝ the operating program is released.

Fig. 18: OTT CTD operating program
release – password input window.

Fig. 17: Protecting the OTT CTD operating
program with a password – input window

to establish a password.

A password-protected OTT CTD operating
program only makes sense if the operating
program starts in observer mode (activate

check box "Only observer mode")!
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How to protect the OTT CTD with a password:

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Click on the "Advanced operation …" button.

(Button not visible? ➝ activate the check box "Advanced operation ..." in the
"Options" function in the "File" menu.)

� Click on the "Read" button.
� In the tree view, select "Communication Interface".
� Enter a maximum eight-digit password in the "Password" input field. Permitted

characters 0 … 9, A … Z. (This password is independent of the OTT CTD
operating program password.)

� Click on the "Program" button.
� Warning: "Reset OTT CTD and delete data memory additionally?" Confirm

with "No" ➝ the OTT CTD is now protected against unauthorized operation.

Caution: If the password is lost, you can no longer configure or parameterize
the OTT CTD. If this occurs, contact the OTT HydroService.

How to release a password-protected OTT CTD

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Select the "Enter password" function in the "OTT CTD" menu.
� Enter password.
� Click on the "OK" button.
� Confirm message "Password accepted! OTT CTD unlocked" with "OK".
� Click on the "Read" button.➝ the operating program reads in the current

OTT CTD operating parameters.

Fig. 20: OTT CTD release – 
password input window.

Fig. 19: Protect the OTT CTD
with a password – input window

to establish a password.
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13 Date and time settings

The internal clock of the OTT CTD is a high-accuracy, realtime clock. It runs as
soon as batteries are installed in the OTT CTD. After the batteries are removed,
the clock will continue to run for approximately 10 more minutes. For longer periods
of power interruption, the OTT CTD loses the date and time. When batteries are
re-installed, the OTT CTD assumes the date and time of the last stored measured
value, with one minute added to the stored time. The date and time are set using
the OTT CTD operating program.

Set the date and time as follows

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Select the "Date/time" function in the "OTT CTD" menu ➝ the operating

program reads the date and time out from the OTT CTD and opens the
"OTT CTD – date/time" window.

� If necessary: click on the "Refresh" button ➝ the OTT CTD reads out the date
and time again.

� If necessary: set the values required in the two input fields.
� Click on the "Set date/time" button ➝ the operating program sets the OTT CTD

date and time to the PC time/date or the values set.

Caution: If the PC is on summer time mode (ID: PC (DST)), the operating pro-
gram automatically uses the standard time without summer correction (winter
time). To receive continuous time series, it is a good idea not to use summer time
in the OTT CTD.
In connection with a GPRS remote data transfer and the "Time synchronization"
function, it is necessary to refer the time to UTC/GMT and to set the time zone of
the station in the "Advanced operation" | "OTT CTD" window. (see online help)

� Click on the "Exit" button. The "OTT CTD – date/time" window closes.

Fig. 21: OTT CTD date and time settings.
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14 Deleting data memory

Caution: The stored measured values in the OTT CTD are permanently lost when
deleting the data memory! If necessary read out measured values before deleting!

Delete the data memory as follows

� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Click on the "Setup device" button in the start window.
� Select the "Delete data memory" function in the "OTT CTD" menu.
� Acknowledge the warning "Are you sure you want to delete data memory?"

with "Yes "➝ the operating program deletes the complete data memory of the
OTT CTD (all measurement channels including the info channel). Afterwards the
OTT CTD determines and saves the water level, the water temperature and the
specific conductivity again in accordance with the sample interval set.

15 Update OTT CTD firmware

If necessary, you have the possibility to update the OTT CTD firmware (operating
system). This makes sense if, for example, devices delivered at different times are
to receive the same operating system version. Updating is carried out via the
OTT CTD operating program. According to availability, an updated version of the
OTT CTD firmware can be found on the internet site "www.ott.com".

How to update the firmware 

� Download the new version of the firmware (file: e.g. "OTT_CTD_V1.00.3.bin")
from the Internet site.

� Copy the file "OTT_CTD_VX.XX.X.bin" to the directory in which the OTT CTD
operating program is located.

� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Select the "Firmware update" function in the "OTT CTD" menu.
� Confirm message with "Yes" ➝ the operating program copies the new

firmware to the OTT CTD. Afterwards the OTT CTD determines and saves the
water level, the water temperature and the specific conductivity again in accor-
dance with the sample interval set.
Caution: During the update, avoid breaking the communication link (e.g by
accidentally removing the OTT DuoLink from the infrared interface of the
OTT CTD.) If the communication link is broken, the firmware will no longer run!
In the same way, no other programs should be started or files opened during
the copying process!

Notes

� If there are multiple ".bin" files in the directory, you will have to manually select
the required file.

� The measurements saved in the OTT CTD are not lost after an update.
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16 Maintenance work

16.1 Cleaning the pressure probe

Recommended interval: every 12 months
with difficult local measuring conditions (heavy deposits):
as required every 4 to 6 months.
(Measurements that are inaccurate or not plausible
indicate a soiled pressure sensor.)

How to clean the pressure probe
� Open the top cap/observation well cover.
� Completely remove the OTT CTD from the observation well.
� Remove the black protective cap.
� Clean the pressure sensor carefully using a brush and water.

Clean graphite electrodes and temperature sensors for the conductivity sensor
with  soapy water and cotton buds. Lime scale deposits can be removed using
a common household scale remover. Make sure to follow the use and safety
instructions of the scale remover!

� Rinse the pressure probe thoroughly with clear water.
� Reattach the black protective cap.
� Recommendation: Calibrate the conductivity sensor (see Chapter 16.4).
� Reinstall OTT CTD (see Chapter 6).
� Determine current reference value with a contact gauge and enter it 

(see Chapter 7.3 or 8).
� Close the top cap/observation well cover.

Fig. 22: Cleaning the pressure probe.

Black
protective cap

Pressure Sensor

Pressure probe with
conductivity sensor

and datalogger

Conductivity
sensor

Graphite
electrodes

Temperature sensor
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16.2 Replacing the desiccant capsules

Recommended interval: Depending on the level of air humidity at the station
every 12 to 24 months and when replacing the batteries.

How to replace the desiccant capsules
� Open the top cap/observation well cover.
� Pull the communication unit approximately 80 cm out of the observation well

and hold (a second person would be useful).
� Slide the pipe casing of the communication unit approximately 30 cm in the

direction of the pressure probe cable. (The rubber stop located on the pressure
probe cable (see Fig. 1) prevents the pipe casing from falling.)

� Remove used desiccant capsules.
� Install 2 new desiccant capsules.
� Slide the pipe casing of the communication unit back on until it stops.
� Slowly and carefully replace the communication unit into the observation well.
� Close the top cap/observation well cover.

16.3 Checking/replacing the batteries

See Chapter 5

16.4 Calibrating the conductivity sensor

The goal of the calibration is to determine the so-called "cell constant" for the con-
ductivity sensor. To do this, it is necessary to check the zero point and to carry out
a conductivity measurement with a standardized calibration solution.

The cell constant – as well as the unchanging geometric measurements, the mate -
rials used and the construction of the conductivity sensor – takes account of the
aging process of the electrodes.

Recommended interval: every 12 months (after every cleaning)
with difficult local measuring conditions (heavy deposits):
as required every 4 to 6 months

Required accessories: standardized calibration solution, calibration container
(see Chapter 2, "Order numbers")

Fig. 23: Replacing the desiccant capsules
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Caution: For an optimum calibration process, the OTT CTD and the calibration
solution must be at the surrounding temperature!

How to calibrate the conductivity sensor
� Carefully clean the pressure probe and dry well (see Chapter 16.1).
� Start the OTT CTD operating program.
� Set up the PC/OTT CTD communication link (see Chapter 7.2).
� Press the "Setup device" button. (Button not visible? ➝ deactivate the "Only

observer mode" check box in the "Options" function in the "File" menu and
restart the operating program.)

� Select the "Calibrate conductivity sensor" function in the "OTT CTD" menu.
� Press the "Start zero point test" button. The operating program starts an instan-

taneous value measurement and updates this every 5 to 6 seconds. If the mea-
surement result displayed (blue triangle) is not in the green area ➝ clean the
conductivity sensor again and dry it well.

� Press the "End zero point test" button.
� Select the calibration solution used. Alternatively, select "Other ..." and enter

the appropriate conductivity value.
� Add the calibration solution to the calibration container (filling height approx. 3/4).
� Place the OTT CTD into the calibration container (screw-on cover in place) and

tighten the screw-on cover by hand. Caution: There must not be any air bub-
bles in the slot of the conductivity sensor! If necessary, lightly shake the calibra-
tion container.

� Press the "Start calibration" button. The operating program starts the instan -
taneous value measurement again and continuously updates it.

� Wait until the values for conductivity and temperature do not change for sever-
al updates. The operating program displays the current and newly calculated
cell constant. Caution: Temperature values shown in red ➝ the conductivity
sensor is not at the temperature of the calibration solution! New cell constant
shown in red ➝ the cell constant lies outside the valid range.

� Press the "End calibration" button.
� Confirm the resulting question: "Save new cell constant?":

– cell constant is within the tolerance range ➝ "No"
(conductivity value is in the green area)

– Cell constant is outside the tolerance range and within the valid range ➝
"Yes" (conductivity value is in red area + current cell constant is shown in
black)

If the cell constant is outside the valid range ➝ error message.
� Close the OTT CTD operating program.
� Rinse the pressure probe thoroughly with clear water!
� Reinstall OTT CTD (see Chapter 6).
� Determine current reference value with a contact gauge and enter it 

(see Chapter 7.2 or 8).
� Close the top cap/observation well cover.
� Dispose of the used calibration solution!

Notes

� Only use the calibration solution once!
� Always store the calibration solution in a closed container! (The carbon dioxide

in the surrounding air and evaporation can change the conductivity value.)
� Avoid water entering the calibration solution! Always dry the calibration con-

tainer carefully after calibration.
� Calibration solution can be disposed of in the normal public sewer system!
� The OTT CTD saves the last three cell constants in a history (see "Advanced

operation ...", channel "Conductivity").
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17 Error messages

If erroneous measurements occur, or if an operating fault occurs, the OTT CTD
stores one of the following error messages in the data memory instead of a
measured value.

� Err 00 internal error (automated measurement)
� Err 01 internal error (AD conversion error)
� Err 03 Exceeded measuring range
� Err 05 An input value required for the measurement calculation is not in the

valid range (example: the temperature value needed for the calculation
of the salinity (standard method) is outside of the valid range :
0 °C ≤ t ≤ 35.0 °C)

� Err 06 An input value for the measurement calculation is missing
� Err 10 Measured value (still) not recorded

Internal errors indicate a device defect if they occur repeatedly.

18 Troubleshooting/fault correction

No communication possible (operating program/OTT CTD) 

� Password programmed?
➝ input correct password.

� Batteries installed?
➝ install batteries.

� Battery voltage lower than about 3.6 V?
➝ insert new batteries.

� Battery contacts corroded?
➝ carefully clean the battery contacts.

� Pressure probe cable damaged?
➝ send OTT CTD to the factory for repair.

� Infrared interface dirty?
➝ clean the infrared interface carefully with a damp, soft cloth.

� Setting measured value not possible?
➝ scaling module missing. Check configuration*

(for advanced operation, see online help).

Communication starts and then breaks off

� Battery voltage lower than about 3.6 V?
➝ insert new batteries.

� Distance from readout unit/IrDA interface to OTT CTD too small/large?
➝ maintain correct distance (see Chapter 7.2).

Erroneous measured values

� Temperature values erroneous
➝ check configuration* (for advanced operation, see online help).

� Pressure sensor values erroneous
➝ check configuration* (for advanced operation, see online help).
➝ check the pressure compensation capillary in the communication unit

(blocked?). If necessary, clean.
➝ check pressure sensor for contamination. Clean if necessary.

* The standard factory configuration is located on the "OTT CTD software" CD-ROM .



� Conductivity values erroneous
➝ check configuration* (for advanced operation, see online help).
➝ check conductivity sensor for contamination. If necessary, clean and then

recalibrate
� Calculated salinity values erroneous (Err 05)

➝ check configuration* (for advanced operation, see online help).
➝ input value is outside valid range:

– salinity by standard method
1.0 °C ≤ t ≤ 35.0 °C for salinity 2.0 PSU ≤ salinity ≤ 42.0 PSU

– Salinity by "USGS 2311" method
0 °C ≤ t ≤ 30.0 °C for salinity 2.0 ppt ≤ salinity ≤ 60.0 ppt

� Observer does not display calculated salinity values
➝ values lie outside the valid range:

– salinity according to standard method
2.0 PSU ≤ salinity ≤ 42.0 PSU

– salinity according to "USGS 2311" method
2.0 ppt ≤ salinity ≤ 60.0 ppt

No measured values in database

� Configuration incorrect?
➝ check configuration* (for advanced operation, see online help).

� Battery voltage lower than about 3.6 V?
➝ insert new batteries.

* The standard factory configuration is located on the "OTT CTD software" CD-ROM .
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19 Repair

� With a problem with the device, use Chapter 18, Troubleshooting/fault correction
to see if you can resolve the problem yourself.

� In case of device defects, please contact the repair center of OTT:

OTT Hydromet GmbH
Repaircenter
Ludwigstrasse 16
87437 Kempten · Germany
Telephone +49 831 5617-433
Fax +49 831 5617-439
repair@ott.com

Caution: Only have a defective OTT CTD checked and repaired by the OTT
repair center. Under no circumstances carry out any repairs yourself.
Any repairs or attempted repairs carried out by the customer will result
in the loss of any guarantee rights.

20 Notes about the disposal of old units

Within the member countries of the European Union
In accordance with the European Union guideline 2002/96/EC, OTT takes back
old devices within the member countries of the European Union and disposes of
them in an appropriate way. The devices concerned by this are marked with the
symbol shown aside.

� For further information on the return procedure, please contact your local sales
contact. You will find the addresses of all sales partners in the internet on
"www.ott.com". Please take into consideration also the national implementation
of the EU guideline 2002/96/EC of your country.

For all other countries
� Dispose of the OTT CTD properly after taking out of service.
� Observe the regulations valid in your country for the disposal of electronic

devices.
� Never put the OTT CTD into the normal household waste.

Materials used
See Chapter 21, Technical data
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21 Technical data

Water level
Measuring range 0 …  4 m water column (0 ... 0.4 bar) 

0 … 10 m water column (0 ... 1 bar) 
0 … 20 m water column (0 ... 2 bar) 
0 … 40 m water column (0 ... 4 bar)
0 … 100 m water column (0 ... 10 bar)

Resolution* 0.001 m; 0.1 cm; 0.01 ft; 0.1 inch
0.0001 bar; 0.001 psi

Accuracy (linearity + hysteresis) ± 0.05 % full scale 
Long-term stability (linearity + hysteresis) ± 0.1 %/a full scale 
0-Point ± 0.1 % full scale 
Overload safe without permanent mechanical damage

0 ... 0.4 bar 4 bar
0 ... 1 bar 10 bar
0 ... 2 bar 15 bar
0 ... 4 bar 25 bar
0 ... 10 bar 40 bar

Units m, cm, ft, inch, bar, psi
Pressure sensor ceramic; temperature-compensated
Temperature-compensated operating range –5 °C … +45 °C (ice free)

Temperature
Measuring range –25 °C … +70 °C
Resolution 0.01 °C
Accuracy ± 0.1 °C
Units °C · °F

Conductivity
Measuring ranges 0.001 … 2.000 mS/cm

0.10 … 100.00 mS/cm
Resolution

0.001 …2.000 mS/cm 0.001 mS/cm
0.10 …100.00 mS/cm 0.01 mS/cm

Accuracy
0.001 …2.000 mS/cm ±0.5 % of measured value (at least ±0.001 mS/cm)
0.10 …100.00 mS/cm ±1.5 % of measured value (at least ±0.01 mS/cm)

Units
0.001 …2.000 mS/cm mS/cm · μS/cm
0.10 …100.00 mS/cm mS/cm

Power supply 3 x 1.5 V batteries (LR6 · AA, FR6 · AA)
alkaline or lithium design
(LiFeS; Energizer L91)

Current consumption 
active, measurement 55 mA
active, communication 65 mA
passive 23 μA

Lifetime (1 h sample interval; 50 m system length; w/o ITC)
with lithium batteries at least 5 years
with alkaline batteries at least 1.5 years (high quality battery types)

Clock
Design real time clock
Accuracy ±1 minute/month (at +25 °C)
Buffer period for battery replacement approx. 10 minutes

Interface Infrared (IrDA)

Storage temperature –40 °C … +85 °C

* at a value range of ±32.750 m; ±3275.0 cm; ±327.50 ft; ±3275.0 inch; ±3.2750 bar; ±32.750 psi
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Data memory
Measurement memory 4 MB
Number of measurements approx. 500,000
Number of logical channels 9 + 1 Info channel
Physical channels (input signals) Water level/pressure

Temperature
Conductivity
Supply voltage

Sample interval 5 seconds … 24 hours
Storage interval (mean interval) 5 seconds … 24 hours

Individually configurable functions – Simple or advanced operation
– 5 extended sample intervals with start/stop time indication, support of

pump tests
– Selection of units
– Pressure/level measurement or depth measurement
– With consideration of the local gravitational acceleration
– Compensate for water density using salinity and temperature
– Temperature compensation for conductivity. Options: Freshwater;

Saltwater; Standard method 2510 (reference temperature: 25 °C or
20 °C); ISO 7888 / EN 27888; none

– Salinity (standard method or USGS 2311)
– Display of instantaneous values with level monitoring function
– Password protection
– Measured value processing: Calculation of mean; delta storage; scal-

ing function; extreme value storage; limit control of the sample interval
– Virtual sensor/virtual terminal
– Together with OTT ITC: alarm management; remote data transfer

Mechanical Data
Can be installed in observation wells 

– with adapter ring 1"
– with adapter plates for top caps 2", 3", 4", (4,5"), 5", 6"

with recess (OTT, HT)
– with suspension brackets for top caps ≥ 2"

without recess/universal installation
Dimensions

Communication unit L x Ø 400 mm x 22 mm
Pressure probe (L x Ø) 317 mm x 22 mm
System length (cable length including 1,5 … 200 m ±1 % ±5 cm
communication unit/pressure probe)

Weight
communication unit (incl. batteries) approx. 0.410 kg
pressure probe approx. 0.430 kg
Pressure probe cable approx. 0.082 kg/m

Material 
Pressure probe housing ABS, POM, stainless steel 1.4539 (904 L)
Cable jacket PUR
Communication unit ABS, PC, stainless steel 1.4539 (904 L)/ 1.4462 (UNS S31803)

Protection class
Communication unit IP 67 (submersion depth max. 2 m; submersion duration max. 24 h)
Pressure probe IP 68 

EMC limits
– Resistance to electrostatic discharge (ESD) complies with EN 61000-4-2 (4 kV contact discharge)
– Resistance to electromagnetic fields complies with EN 61000-4-3 (10 V/m)
– Resistance to transient fields (burst) complies with EN 61000-4-4 (2 kV)
– Resistance to surge complies with EN 61000-4-5 (4 kV)
– Resistance to HF, asymmetric complies with EN 61000-4-6 (10 V)
– Line-borne and radiated interference complies with EN 55022 Class B (30 … 1000 MHz)
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Appendix A – Declaration of conformity for OTT CTD
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Document number
55.445.001.B.E 02-0411

OTT Hydromet GmbH

Ludwigstrasse 16
87437 Kempten · Germany
Tel. +49 831 5617- 0
Fax +49 831 5617- 209

info@ott.com · www.ott.com


